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Introduction 

Overview 
This user guide will step you through how to set up and use the Purchasing Entry module. This module is its own 
module that is included in the core programs. Accounting set up must be done prior to using the purchase order 
module. This document will not cover the accounting set up. Additional questions or training is available from 
your EFI PrintStream support staff. 

Contact Information 

EFI Support 

US Phone: 855.334.4457 (first select option 3, then press option 8, then press option 1) 

US Fax: 415.233.4157 

US E-mail: printstream.support@efi.com  

 

Regular Service Desk hours are 8:00 AM to 7:00 PM Central Time, Monday – Friday. Outside of these hours, 
you may leave a voice mail message and an on-call support representative will be paged. Response time is 
based on the severity of the issue. 

Note For problems involving infrastructure (i.e., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of 
issues. 

EFI Professional Services 

US Phone: 651.365.5321 

US Fax: 651.365.5334 

E-Mail: ProfessionalServicesOperations@efi.com 

 

EFI Professional Services can help you perform EFI software installations, upgrades, and updates. This group 
can also help you implement, customize, and optimize your EFI software plus offer a range of training options. 
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Set Up 

Preferences 
To open, select Purchasing Entry from the Purchasing menu.  

 

Then select File > Preferences. 
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Databases Menu 

Warning Only select if the database is set up as multi company or multi plant. 

 Will allow up to 9 plants or companies 

 If checked, can easily switch between plants/companies 

Purchase Order Report 

Print: 

 Item Number: Will print the item number on the Purchase Order. Item Number found and auto assigned 
in Master File Inventory. 
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 Item Code: Item code will print on the Purchase Order. Item code found in the Master File Inventory 
and is editable. 

 

 

Note May toggle or change this setting and re-print or preview the purchase order. 

 By Default Print - Enter how many copies should print each time the PO is sent to the printer 

 PO: Use Paper Description (No Plant Code definition in description on PO): Select this option to 
display the Plant Code in the item description. 
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Screens / User Interface  

 Confirm Exit from Application: If checked, the system will produce a warning message upon exiting. 

 

 Initial Screen 

PO Search - Default to the search screen upon opening the purchase order module. 

New PO - Default the opening screen to a new purchase order entry screen. 

Blank - Default the opening screen to just the tree. 

Data Entry 

 Copy First line item due date: This option will copy the due date entered in the first item of the 
purchase order to subsequent lines. The date can be changed. 

 Default to __ days from today: This field, if checked and a number is entered, will automatically fill in 
the Due Date field with the date the number of days from today that is entered.  The date can still be 
overridden. 
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 Copy Job Details to line item Desc: If checked, all job-related PO line items will contain this 
information from the corresponding job. 

Example: 

 

Corresponding PO line (Note Job Title:  test for class). 
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If not checked, no corresponding Job title:  

 

Options: Select Company/Plant 
Upon opening the program, the system will default to the company/plant the user is logged into. If the user has 
security access to the other companies/plants defined in the database, then the user can change the default 
company/plant. 

Options >Change Company/Plant. 

 

Highlight the plant and select ok: 
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Report Formats 
There are a variety of crystal report formats for Purchase Orders.   

 

The password to view the additional report formats is formats. 

 

 

Footer Set-up 
To include a note or comment on the footer of all purchase orders select: 

Master File Reports > System Maintenance > Module Definition File: 
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Select PO Defaults and Purch Order Footer, then click the Display button. 

 

Click the OK button to save and close the data entry screen.  Remember, this will print on ALL purchase orders. 
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PO Approval 
PrintStream offers an approval process to approve purchase orders prior to previewing or printing them. This is 
an optional setting; defined at the plant level for each plant defined in the database. It is setup in Master File 
Reports/Production System/Plants (for the System). To activate this feature, highlight the plant you wish to set up 
and then check the PO: Approval required checkbox.  Don’t forget to click the Save button to complete the 
process. 
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New Purchase Order 

To create a New purchase Order  

1. Select: File > New Purchase Order. 

  

2. In the Select Vendor window enter/select the following: 

  

Date  Automatically defaults to current date, but can be changed 

Reference  Optional character field check will print on the PO when certain formats are selected 

Ordered By  Defaults to the system login name of the user 

Vendor Must be a current Vendor in Master File Vendor. Either enter the in Code in the small box, to 
the left, or enter the Name in the long box to the right (case sensitive in the search) 
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3. Click Next. In the Shipping Information window, the Address will default to the PO shipping address 
which is defined for the plant in Master File Reports/Production System/Plants (for the System) 

  

  

4. (optional) To change the address type directly into the address fields or by click the search button to the 
right of the Ship To field and select from the list of additional shipping addresses. 
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 Ship Via and Attention fields are optional, free form fields that will print on PO. 

4. Select the Finish button, when done. 

  

Note  Set up additional shipping addresses under your company name in Master Files Customer. Select the 
Addresses button. 
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A new PO will open: 

 

Order # System assigned sequential number which cannot be altered 

Date Defaults to the current system date, but may be edited 

Ordered By Defaults to log in users ID 

Ref Optional field which will print on the PO 

Rev # System generated revision Number; tracking how many times the PO has been altered 

Rev Dt Displays a system generated date of the last revision 

Rev By Will display the ID of the user who made the last revision 

Vendor: Number, Name and Address entered in opening screen. Can change if needed (must be a 
valid vendor from Master File Vendor), select the search button to change. (…) 

Currency Type:  Reference only cannot be changed. 

Ph:  Phone number. Entered in Master File 

Fax:  Fax Number Entered in Master File Vendor 

Ship To and 
Address:  

Brought in from the screen previously filled out. Can edit or change the current address field by 
highlighting and re-typing the address. Click the search button (…) to select from the list of 
additional shipping addresses. 

Ship Via:  (optional) Brought in from the screen previously filled out but can be edited. Will print on the 
PO. 

Ship To Attention:  (optional) Brought in from the screen previously filled out but can be edited. Will print on the 
PO. 
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Add Line Item  
Select the Add Line button (bottom/left), to add a new line item.  

Six Types of PO Line items: 

 Job Related Multi Item: Purchases directly tied to a job. (Buyout/Subcontract).  This option allows you 
to select multiple buyouts for one job to the vendor assigned to the purchase order. 

 Job Related (single item): Purchases directly tied to a job. (Buyout/Subcontract) This option allows 
you to select one buyout at a time for one job. 

 Non-Inventory: Expense immediately. Will not get used on a job. (Office supplies). 

 Paper Inventory: Has dollar value/asset account. (Paper, envelopes. Print system only). 

 Finished Goods: Has dollar value/asset account. (Binders, Diskettes used for a job). 

 Material Inventory: Has dollar value/asset account. (Raw Materials: Ink, Labels, Plates). 
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Job Related – Multi Item 

 

1. Enter or search for a Job # and select Load.  

  

2. If the job selected has been final AR invoiced, the notation Final Billed will display in red to the right of 
the job description. Job related purchase orders cannot be created if the job has been final AR invoiced 
to the customer. 

  

3. If the Ordered column reflects an N, then the PO line item has not been ordered. Y indicates the PO 
line item has already been purchased. 
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4. Select the Tag check box to order each item or select the Check All button to select all buyouts for the 
job. Enter the Due Date and Tax Code. Then click Create PO Line Item. 

  

Note If you receive the error message, “activity code has an invalid A/P dissection code” after you 
select the OK button, this indicates the database is not setup to utilize the Purchasing module 
or you have not properly linked the activity code assigned for the process to a valid AP 
Dissection code in Master File Reports/ Accounting Structure / Link to Purchasing. Consult 
your system administrator or your EFI PrintStream Accounting Support contact. 

5. After selecting Create Po Line Item, PrintStream will show the number of PO lines added.  Click 
Cancel or the X in the upper right-hand corner to close this window. 
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6. The lines selected will now display on the header page of the purchase order.   

  

7. Click Save. 

Job Related (Single Item) 

 

1. Enter or search for a Job # and select Load. 
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2. You can manually enter in the material to purchase or click Planned Purchases to view a list of 
buyouts or materials related to the job number. 

  

 In the Description column, items with a dark circle have been ordered.  Those with a light circle have 
not. 

  

3. Double click the line to be ordered and enter or change any information as needed: 

 Mandatory fields (in bold) are:  Qty/Hrs, Price, Price Per, Due Date, Activity Code and Tax Code 

 PrintStream will calculate the cost based on the quantity and price defined.   
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PO Line Item Notes 

Click Notes to enter line item descriptions. If a script was attached to a buyout, the script answers will appear in 
the Notes field. 
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These notes will appear in Inventory Manger / Scripts/Po Notes when the item is selected to be received. 
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List of Activity Codes 

If needed, enter a required Activity code directly into the field. You can also scroll using the mouse, use the 
up/down arrow keys or select the Search button (binocular icon) to search for a list of activity codes. Double-click 
to select or highlight and click OK. 

Note  If you receive the error message, “activity code has an invalid A/P dissection code” after you select the 
OK button, this indicates the database is not setup to utilize the Purchasing module or you have not 
properly linked the activity code assigned for the process to a valid AP Dissection code in Master File 
Reports/ Accounting Structure / Link to Purchasing. Consult your system administrator or your EFI 
PrintStream Accounting Support contact. 
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Click Save when you are finished. 

Non-Inventory 

 

Enter in the information for what is being purchased. System will calculate the cost 

Mandatory fields:  

 Order Date 

 Qty/Hrs 

 Price 

 Per 

 Due Date 

 AP Code 

 Tax Code. 
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Click the OK button, when finished. 

Paper Inventory 

This line type allows the user to purchase paper inventory held in the warehouse and used for multiple jobs; not 
specifically purchased for one job. 

 

1. Enter the paper item number or click the search button (binoculars icon) to search it. 
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 The search inventory screen will open. 

  

2. Enter the information known or click Search. The number of records loaded will be displayed.  

Note By default only 300 records are displayed at a time. This default can be changed so more 
items may be available which meet the criteria.   
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3. Select the item to order and then click on the Select button or double click on the item itself. 

 The information stored in the system for this item is automatically populated. 

  

 Enter information into remaining mandatory fields: Quantity, Price, and Due Date. 

4. Click Reservations to see all job quantity requirements for this item. 
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Finished Goods 

 

1. Select Add Line and then select Finished Good to add a new line item. 

2.  Enter or search for the Item #, or you can create a new finished goods item from within the Finished 
Goods Line Item window. 

3. After selecting the finished goods item, verify: 

 Qty/Hrs 

 Price 

 Price Per (if new otherwise will bring in the price per) 

 Due Date 

 Activity Code 

 Tax Code 

4. Click OK when finished. 

Material Inventory 

 

1. Select Add Line and then select Material Inventory to add a new line item. 

2. Enter or search for the Item # or create a new material item from within the Raw Materials Line Item 
window. 

3. After selecting the material item, verify: Qty/Hrs, Price, Price Per (if new otherwise will bring in the price 
per), Due Date, Activity Code, and Tax Code. 
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Edit or Delete a Purchase Order Line Item 
To edit or delete a line Item, highlight; right-click and select Edit or Delete Line Item. You can also select the 
line item and choose the Edit Line or Delete Line button.  
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Receiving Instructions 
Notes, which will print on the receiving ticket or display during the actual receipt of the item, can also be entered.  
Click Receiving Instructions, enter the text and click Save. 
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Update Job changes 
This feature will take any changes done in the estimate and overwrite the PO changes, for example, notes, 
scripts, etc. 
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Header Notes 
Header notes can be entered against the po and can only be viewed from this area. 

 

  

Commented [MB1]: Need description. 
Brandon Turpin – descripton added. 
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Preview, Print, Export / E-mail a PO 
 1. To preview a PO, select the purchase order displayed in the tree and click the Preview Selected 

Purchase Order button from the menu. You may also select the Preview option located at the bottom 
of the PO header window.  

  

 To print the purchase order, select the purchase order displayed in the tree and click the Print icon. You 
can also select the Print option located at the bottom of the PO header window.  

Note To change the default printer, select File > Print Setup. 

  

Note  If you receive a message, “This PO Requires Approval First” when trying to preview or print 
the purchase order, somebody with security access to approve purchase orders must approve 
the PO before continuing.  

 If you want the Purchasing Approval option turned on or off, contact your System 
Administrator. 

 To export the Purchase Order, first preview it and then select the Export button from the menu 
(envelope with the red arrow pointing down). Choose the format you want to which you want to export 
the PO. 
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The PO can also be printed or exported/emailed by selecting one of the two icons at the top of the preview 
screen. 

 

Receiving a PO Line Item – Inventory Manager Module 
1. To manage all Job or Non Job-Related Receipts, open the Scheduled Tasks screen. 
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2. Select a date range then click Search Now. Double-click a line item to start the receipt process. 

  

 Or select the option for New PO Receipt. 
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 The Receive from PO screen will open. Enter the PO number, in the field to the upper left, and then 
press the <Tab> key to display the line items. Double-click a line item to start the receipt process. 

  

3. If the line was for a miscellaneous or job-related item, the Receive Non-Inventory window will open.  
Enter in the quantity and press the <Tab> key and the cost will populate automatically. Click OK to 
finish, then answer the question about whether the receipt for this line item is final. 
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4. If the line was for an inventory item, the Receive Locations window will open. Enter the quantity in the 
Skids, Ctns, Pcs Per Ctn and/or Loose pieces fields and click Insert.  

 Enter a location or select Search to pick from a list of all locations. Click the OK button to finish, then 
answer the question about whether the receipt for this line item is final. 

  

  

5. Once a PO has been received, it will be removed from the Scheduled Tasks list after you select the 
Search Now button again. 
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Receive All Job-related 
For job related line items, multiple receipts can be entered all at once by clicking the Receive All Job-Related 
button. 
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Edit or Remove a PO Receipt 
To edit or remove a PO after it has been received or removed from the Scheduled Tasks list, open Inventory 
Manager module > Receiving> New PO Receipt. 

 

In the Receive from PO window, enter the PO # and press the <Tab key> to display the information. Select the 
line item and then highlight the line item under Receipts (bottom half of the screen). Click Edit or Remove. 
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Printing Various Receipt-related Items 
1. Select New PO Receipt (Inventory Manager module > Receiving) 

 

2. Enter the PO # and press the <Tab> key to display the information. To print receipt tickets for all 
receipts made against a PO, click View/Print All receipts. 
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3. Select the individual receipts, either by checking the box in the Tag column or using the Check All 
button. Once the selections have been made, click the Print Rcpt Ticket button. 
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4. To preview or print a Receipt, Skid Ticket or Skid Tag/Sticker for a single receipt, select the receipt and 
click Print. 
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Approve Purchase Order before Printing 
1. To approve a PO, select the Purchasing Approval Module. 

  

2. Under the Status column, insert a check mark in the gray box provided for each purchase order 
approved.  

3. To locate a single purchase order to approve, enter the purchase order number in the PO No field and 
select Load PO Items.  

 You can also enter the Vendors account number to display the purchase orders requiring approval for 
the selected vendor. By not entering a specific purchase order number or vendor, and selecting Load 
PO Items, PrintStream will load all purchase orders requiring approval.  

4. To change the way the list is sorted, single-click the Due Date, Order #, Job # or Status column bars. 

Note  If you want the Purchasing Approval option turned ‘on’ or ‘off’, see your PrintStream System 
Administrator. 
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PO Reports 
To view reports, select Reports > PO Reports. 

 

 

There are four reports available: 

Overdue PO Report – Lists all PO’s that have not been received as final.  It can be sorted by PO#, PO Date, 
Vendor Name or GL Code#.   
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PO Receipts Accrual Report – lists all PO receipts which have not yet been AP invoiced or dummy invoiced, for 
a specific date range.  It can be sorted by PO#, PO Date, Vendor Name or GL Code#. This report is used to 
determine numbers for an AP accrual entry at month end. 

 

PO Without AP Invoice Report – can be filtered for final and partial receipts, using specific date ranges for both 
statuses. This report will also include receipts that have been dummy invoiced. 

 

Unapproved PO Report – lists all open PO’s which have not yet been marked as approved. This report can be 
run for a specific date range or it can be generated to include all unapproved purchase orders. 
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Utilities 
The Utility option on the taskbar in the Purchasing program provides two utilities. 

 

Mark Purchase Orders as Closed 
The first utility, Mark Purchase Orders as Closed, is a utility which allows the user to mark outstanding 
purchase orders as closed. You will need to obtain the password to access this utility from your PrintStream 
support person. An outstanding purchase order is a purchase order that has been received, but not AP invoiced. 

This utility has consequences if not used properly. Please see the ramifications for the different purchase order 
types. 

Inventory purchase orders – When an inventory purchase order is received into PrintStream, the quantity of 
the item as well as the value per the purchase order price will be updated.  The general ledger is not updated 
with the value of this purchase until the AP invoice is entered.  If this utility is used on an inventory purchase 
order, the only way the general ledger will be updated to reflect this purchase is if 1) a journal entry is created to 
debit the inventory asset account or 2), a miscellaneous AP invoice is entered and coded to the inventory asset 
account. 

Job related purchase orders – When a job-related purchase order is received into PrintStream, the costing 
against the job is updated based on the value on the purchase order.  If the AP invoice is not entered prior to the 
final AR invoice is created for the job, a dummy invoice (cost accrual), will take place on the final AR invoice to 
accommodate the outstanding purchase order.  If this utility is used on a job-related purchase order, the dummy 
AR invoice will remain on the Dummy AP Invoice report.  This report is the subsidiary for the AP without Invoice 
general ledger account. The only way this report can be cleared is to enter the AP invoice to the job-related 
purchase order.  Therefore, the dates for this report will have to be changed to only reflect a current range, or a 
manual calculation will be required to back-out the value of this outstanding purchase order.  It is NOT 
recommended to use this utility on job related purchase orders. Instead, enter an AP invoice into 
PrintStream, associate it to the job-related purchase order, enter a miscellaneous item to this invoice and 
allocate the miscellaneous line to the same expense account impacted during the dummy invoice process. 

Miscellaneous purchase orders – This utility does not have any adverse effect on miscellaneous purchase 
orders. 

To use Mark Purchase Orders as Closed  

1. In the Bulk Close PO window, select either the Use Due Date or Use PO Date option, and define the 
From and To dates. Click Load Uninvoiced button. The grid will load based on the criteria entered. 
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2. Select the checkbox in the Close PO Line column to choose the purchase orders you want to close.  

 Or, select the Mark All option to choose all POs. The Mark Zero Amount option will select the 
purchase orders that have a $0.00 value. If either radio option is used, then select Check All Records.  

 After the purchase orders have been selected, click the Close Marked button. 

  

3. PrintStream will provide the following confirmation after marking the selected purchase orders to close. 
Click OK. 
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4. In the event a purchase order marked as cleared continues to show on an open purchase order report, 
click Fix Incomplete Data. This option will confirm the ORDTRANS table is updated with the 
information that the purchase order(s) has been marked as cleared. 

  

Delete This PO 
The second utility is the ability to delete a purchase order.  

Note  A purchase order can be deleted if it does not have any line items on it. 
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AP Invoicing PO Receipts 

Vendor Invoice for a Single Purchase Order Receipt 

To create a vendor invoice for a single PO 

1. Create a batch as described in the AP Invoicing Entry document or continue working within an un-
posted batch. 

2. Create a new invoice by right clicking the batch number and selecting New Invoice. Or from the toolbar 
select Batch > New Invoice. On the AP Header screen define the invoice number, date, vendor, 
etc.  There are two methods of how to invoice a purchase order receipt. 

3. After defining the AP Header screen, click Save Header. From the Invoice Lines tab, click the New PO 
Line button on the Invoice Line task bar. If the purchase order you are invoicing against was received 
elsewhere in PrintStream, select the Order Receipts option. 
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4. In the order field provided, enter the purchase order number, or with your cursor in the field, use the 
up/down arrow key on the keyboard to scroll through the available purchase orders. Once selected, 
press <Tab> and the line items from the purchase order received elsewhere in PrintStream will display 
showing the receipt date, part or final receipt, quantity received and a description. If the receipt is 
marked as final, then you can proceed to invoice. 

 Any purchase order line item, or partial line item, that has been previously AP invoiced will not display 
for selection. 
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5. Select the purchase order line and then click Next (you can also double-click on the line item) to open 
the Add New PO Related Line window. 

  

 Make any necessary changes and then select either Save, Start New Misc Line or Save And New 
Invoice. The purchase order line item selected will pull through onto the invoice. 

Note  You can edit the unit price, subtotal, description, tax code and dissection code fields for non-
inventory, finished goods, material inventory and paper inventory related purchase 
orders.  The unit price, subtotal, description and tax code fields can be edited for job related 
purchase orders.  If edits are required to material inventory purchase orders, it is highly 
recommended the changes be made on the purchase order rather than at the time of AP 
Invoicing. 
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 When the PO receipt address differs from that of the AP invoice, then the address field will have a red 
background and a warning message will display. However, this warning will not prevent the PO line item 
from being AP invoiced. 

  

 If you do not see a receipt, or the receipt is a partial receipt for the PO line item you are trying to enter, 
then you may be able to receive it into PrintStream at the same time the AP invoice is entered.  This is 
applicable for non-inventory and job-related purchase order line items only. 
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6. Select the Auto-Receive as Final option to display the PO line items that have not been received 
elsewhere. Enter the purchase order number in the order field provided or, with your cursor in the field, 
use the up/down arrow key on the keyboard to scroll through the purchase orders available.  Once 
selected, press <Tab> and the line items from the purchased order not received will display. 
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7. Select the purchase order line item you wish to receive and then click Next (or double-click the line 
item) to open the Auto-Received PO Line Item window. 

  

 Make any necessary changes and then select either Save, Start New Misc Line or Save And New 
Invoice. The purchase order line item selected will pull through onto the invoice. 

Note If the quantity you wish to mark as received is different from what was ordered, you should 
NOT do the auto-receipt from the AP Invoicing program.  Use the Inventory Manager program 
to adjust the quantity received. 
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8. Selecting the Auto-Receive Balance on Partial Receipts option will display the remainder of PO line 
items that have been partially received elsewhere. Enter the purchase order number in the order field 
provided or, with your cursor in the field, use the up/down arrow key on the keyboard to scroll through 
the purchase orders available.  Once selected, press <Tab> and the remainder of the PO line items 
partially received will display. 
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9. Select the purchase order line item you wish to receive and then click Next (or by double click the line 
item) to open the Auto-Received PO Related Line window. 

  

 Make any necessary changes and then select either Save, Start New Misc Line or Save And New 
Invoice.  The purchase order line item selected will pull through onto the invoice. 

Note If the quantity you wish to mark as received is different from what was ordered, you should not do the 
auto-receipt from the AP Invoicing program.  Use the Inventory Manager program to adjust the quantity 
received. 
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Vendor Invoice for Multiple PO Receipts 

To create a vendor invoice for Multiple PO receipts 

1. Create a batch as described as described in the AP Invoicing Entry document or continue working 
within an un-posted batch. 

2. Create a new invoice as instructed earlier in this document; define the invoice number, date, vendor, 
etc.  Select the Start PO Lines option to open the Multi PO Selection window. 

  

Note The purchase order line transactions displayed in the above grid are the receipts made to 
purchase order line items.  Purchase Order line transactions that have not yet been received 
into PrintStream will not show in the Multi PO Selection grid. 

 Line transactions displayed in red (as shown above) indicate the purchase order has been dummy 
invoiced in AR Invoice Entry, but the AR invoice has not yet been posted. In this case, the AP 
invoice cannot be entered until the AR invoice batch is posted or the dummy Invoice is removed 
from the un-posted AR invoice.   

 Line transactions displayed in white indicate the address of the PO receipts is different from the 
address selected in the AP Invoice Header. PrintStream will provide a warning if one of these 
receipts is selected, however, it will allow you proceed with invoicing the receipt. 

 Line transactions displayed in yellow indicate the address of the PO receipts is the same as the 
address selected in the AP Invoice Header. 

 All received Non-Inventory, Job Related, Finished Goods, Material Inventory and Paper Inventory 
purchase orders will display in the Multi PO Selection grid.  
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3. To select the purchase order line items you want to invoice, select the grey checkbox at the beginning 
of the line. 

 

4. After selecting the PO line items to be invoiced, select the Invoice the Selected Receipts button.  As 
the program reads through the purchase order lines you have selected, you will see the lines change in 
color to green.  When the program has completed reading through your selections, select the X located 
in the upper right-hand corner of the Multi PO Selection screen.  The purchase order line transactions 
will pull through onto the invoice line screen. 
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5. To edit a purchase order line transaction in the invoice lines tab, you can either double click the line or 
select the line and click Edit Line from the Invoice Lines toolbar.  After the changes have been made, 
select either Save, Start New Misc Line or Save and New Invoice. 

  

Note The unit price, subtotal, description, tax code and dissection code fields can be edited for non-
inventory, finished goods, material inventory and paper inventory related purchase 
orders.  Only the unit price, subtotal, description and tax code fields can be edited for job 
related purchase orders.  Edits at the time of AP invoicing is not recommended for valued 
inventory.  Please make edits directly to the purchase order in Purchasing Entry. 

 Dissection/GL codes default according to the code reflected on the purchase order, not the dissection 
code defined in the Vendor’s MasterFile.  

 Changing the dollar amount of an invoice entered against a received inventory related purchase order 
may change the average price value of the inventory. 

  



64  EFI PrintStream | User Guide 

 
 

 

2014 Manage Supply Codes 

Overview 
This module was designed for the purpose of creating supply codes and generating purchase orders by 
department in cases where materials that are not tracked through the PrintStream Inventory modules may be 
ordered on a repetitive basis by one or more departments.  

Manage Supply Codes allows you to create new codes for these materials as well as the editing of existing 
codes. It is also possible to flag a supply code as Active or Inactive or to Delete a code, provided there is not an 
open PO for the item.  

It features a Supply Order List which shows On Order Quantity based upon open purchase orders by 
department. The printed list is distributed to each department. Additional columns on the list, On Hand Quantity 
and Order Quantity are filled out manually by each department and the list is returned to Purchasing to create 
purchase orders. 

There are options to print the list of supply codes by individual department or for all departments, to view 
purchase orders created within the module, and in other Purchasing modules, and to search for existing 
purchase orders. It is possible to view, edit, preview and print purchase orders from within the module. The 
Search PO window displays the status of a purchase order as “no receipt”, “partial receipt” or “final receipt” as 
well as the due date on the, PO#, and description of supply code and AP invoice status. 
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Manage Supply Codes 

 

Search 

You can search on all available Supply Codes by leaving all search options blank or select one or more of the 
available search options to narrow your search results: Supply Code, Description, Department, Vendor, 
Dissection Code. There is also an option to view only Active supply codes. Click Search to view results. 

Add Supply Code 

Enter the following fields to create a supply code and click Save when done.   

 Code (20 character maximum) 

 Description (25 character maximum) 

 UOM (Unit of Measure-alpha-numeric 25 character maximum) 

 Select Default Department, Departments are setup in Master Files Reports under Production 
Departments. 

 Select Default Vendor (pulls from Master Files Vendor) 

 Price per UOM 

 Tag one or more Departments that may order this item, select Dissection Code  

 Option to select additional vendors, select a different vendor enter the price and UOM then click Add to 
Grid. Having one supply code with multiple vendors attached will give the user creating the PO’s the 
ability to switch vendors on any supply code which has multiple vendors attached. 
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Edit Supply Codes 

Highlight the supply code and click Edit Supply Code. 

 

Enter the changes and Save. 
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Options to edit Code, Description, UOM, Default Dep’t, add new Vendor, select/deselect departments (same 
options as available when adding new code) 

 

Print Lists 
Selection Options: 

Select / Clear All Departments 

Report Options: 

Preview to Screen 

Print 

Export 
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Supply Order Sheet 

Supply Order Sheets may be printed and distributed to each department. Supply Order Sheets display: 

 Supply Code 

 Item Desc 

 UOM 

 On Order Quantity (-will display the quantity not yet received on an open PO) 

 PO No 

 Due Dt 

 On Hand Qty (used to write in the amount currently on hand in the department) 

 Order Quantity (used to write in the amount the department is requesting to be added to a PO) 

The completed sheets are returned to Purchasing for use in creating purchase orders. 
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Order Supply Codes 

To order supply codes 

1. Opening screen defaults to show all items in all departments. Place a check next to the department to 
close the list for departments that are not ordering supplies. 
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2. Select the item and click Order Supply Codes.  

3. Enter order quantity, due date,  

4. Default Vendor or option to select other vendors  

  

5. After Quantities and dates are entered for all items click Create PO. 
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Created PO’s 
Created PO’s lists Purchase Orders created in the current session. 

 

Double click on PO number to view line item 

Select option to Preview or Print PO. 
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Search PO 
The Search PO window has similar options to the Purchasing module search screen with the exception of the 
Inventory fields (since this module is used to track non inventoried materials, only the Item # is not used here.) 

 PO 

 Supply Code 

 Vendor 

 Item Number (not functional in this module-for Inventory only) 

 Due Dt greater than  

 Part or Final 
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2014 Scheduled Purchasing 
The Scheduled Purchasing module helps you to manage your purchasing and inventory departments. The status 
of all purchasing transactions and inventory requirements can be viewed from this window. This program was 
developed primarily for the print and print and mail industry. Scheduled Purchasing works in conjunction with the 
Paper Reservation Screen found in both the print and print and mail programs. 

Task List 
The information in this tab is the status of inventory materials attached to jobs. The filters allow you to sort by a 
single job or filter selection by inventory statuses on jobs.  To sort by job, enter the job number in the Job # field 
and click the Search button. 
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All inventory items related to this job are listed. The Workflow column indicates the status of each inventory item 
on the job. The statuses are as follows. 

 Ord/Rsv: This status indicates that the inventory item has been ordered and reserved. The purchase 
order number is displayed in the PONO column. You can view or edit the PO for this item by right-
mouse clicking on the line. 

 Un-Confirmed: Indicates that the inventory item has not been reserved for the job. 

 Reserved: These inventory items have been reserved for this job.  

If you want to update the status for any of these items double-click the line to open the Paper Reservation 
window.  As you click on each line, the relevant information for that item is displayed at the bottom of the screen. 

Search Criteria  

This feature allows you to select the dates for filtering the information displayed on the screen. The search 
criteria are used with the Selection feature. You can search by the following methods: 

 All: Includes all inventory items for all dates sorted by job and job due date. 

 Start Date/End Date: Includes all items for all jobs with due dates between start and end date 
specified. 

 Selection Type: Filters the information displayed on the screen by category and search criteria 

 Vendor: Displays information for selected Vendor Only. 

 Key Word: Filters display of Details based on Key Words entered. 

Completed Jobs Selection 

 Completed Jobs: Displays inventory items for all jobs invoiced as final. 
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Need to Order Selection 

 Need to Order: displays all items by job number that have been reserved or unconfirmed where the 
inventory commitment is more than the available on hand quantity. 

 



V21.1.0200 Purchasing User Guide  77  

 
 

 

Order Items 

Items can be directly ordered through this window by clicking on the box for the line item to order and then 
clicking the Order button. 

 

The PO Window 

The PO window displays the line item information for the selected line. Fill in the Vendor and Ship To information 
and then edit the line to enter due dates and confirm quantities and pricing, then Save the PO.   

You can select multiple lines for inventory on the same job and different jobs if they are for the same vendor and 
they will all be added as different line items on the PO.  Once the PO’s have been created and saved the screen 
will refresh and all the ordered items will drop off the listing. 
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Ordered Selection 

 Ordered: Displays all items that are currently ordered. You can view or edit the PO for any item by 
right-mouse clicking on the line that you want to edit or view. This window also shows the PO due date 
and receipt date of the PO. 
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Other Selection Options 

 Planner Replaced: This feature works with the Paper Reservation screen it shows any items where the 
paper selected on the order does not match the reserved paper.  These changes were made through 
the Paper Reservation screen. 

 Purchasing Replaced: Displays items where the paper selected on the order does not match the paper 
reserved.  In this case the reservation change was made through Scheduled Purchasing by clicking on 
the line item to bring up the Paper Reservation window. 

 Reserved: Shows all items by search criteria that are reserved. 

 Un-Confirmed: Shows all items by search criteria that are not reserved. 

 Special Order: Displays a list of all paper items that are not in inventory where the “Order” button was 
checked in the Paper Reservation Screen.  All these items are flagged to be ordered on Job Related 
PO’s. 

 Key Word: displays information for all items in search criteria that match the key word entered.  The 
key word must match part of the inventory description. 

 Vendor: displays information for all items that are from the vendor selected.  The vendors are attached 
to the inventory items in Inventory Master File, Item Links screen. 
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Inventory 
The Inventory window allows you to sort and manage all inventory items. It displays reservation information and 
PO status for each inventory item displayed. Inventory items can be ordered for stock or related to specific jobs 
in this window. 

Inv Type 

Select any of these options and click Search to filter the inventory display by these categories. 

 

  Paper Rolls/Sheets: Has dollar value/asset account. For example, Paper, 60# Offset White (Print 
system only). 

  Materials: Has dollar value/asset account. For example, Ink, Labels, Plates, Film, Boxes. 

  Finished Goods: Has dollar value/asset account. For example, Binders, Pre-Printed Shells, Boxes, 
Diskettes used for a job. 

Note  All of these options can be used in conjunction with any of the other options in this window to narrow 
your search. 

Type 

There is a field in Master Files - Inventory in the Main Information Screen that will allow you to apply an Inventory 
classification to each item. The inventory can then be filtered by these classifications: House, Consignment, 
Customer Owned, Others. 

 

Category 

This option applies to print and print and mail customers only. It allows you to sort by the “Paper Types” setup in 
Master Files - Print under Miscellaneous. These paper types are linked to each paper in the Paper Master File. 
(For example, Coated Book, Uncoated Book, Envelopes). 
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Sub Category 

This field works in conjunction with the Category option. It is also designed for print and print and mail customers 
only.  The subcategories are set up in Master Files Print in the Paper Types screen and are attached to the 
individual papers in the Paper File. 

 

Job 

This option will display a listing of the reserved materials for the job entered. 

 

Item 

Displays the status of the inventory item entered on the screen. 

 

Prod Cd 

Searches by Product Code attached to Inventory 
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Due Dt Range 

If this box is un-checked, then all items which meet the search criteria will be displayed regardless of the job 
status.  

If this option is checked, then you can set the date range to filter the display based only for items on jobs which 
fall within that date range. The criteria that the date range uses are based on the “Reserve Due Dt” type 
selected. 

 

Reserve Due Dt 

This works with the date range selected and filters the information based on date range in the following ways:  
Job Due Date, Scheduled Paper Approval Date, Paper Due Date, Scheduled plate making date, or Scheduled 
printing date. 

 

Key 

Displays inventory items whose descriptions match the text entered. 

 

Color 

This option allows you to sort by paper color and is only available for print and print and mail customers. 

Note Before you can select a color you must first click Load which will load all of the paper colors into the 
color window. 
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Weight 

The display sorts papers by the basis weight entered. This is only available for print and print and mail 
customers. 

 

 

Size 

For print and print and mail customers only. Sorts papers by size entered. If searching for roll stock, then only the 
roll width or first dimension is required. 

 

Negative Avail 

Displays all inventory items that have a negative balance due to over reservation of the inventory item.  

 

Inc On Order 

Displays items that have been ordered through a Purchase Order but are not yet received. 
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Below Min Qty 

Displays all inventory items which have a minimum level set in Inventory Master File and the current amount on 
hand is less than the minimum level. 

 

Excl zero Qty 

Excludes items with a zero quantity from being displayed. 

 

All jobs that have Reservations for an Item 

For each inventory item displayed you can see the status for: on hand, on order, allocated, available, minimum 
level, vendor code and name.  

If the inventory item shows numbers in the on order or allocated columns, then you can click on the item and it 
will display, in the bottom left corner, all the jobs that have reservations for that item.  

If there are numbers in the on-order column, then if you click on the item it will display the PO status for each PO 
written for that item. 

  



V21.1.0200 Purchasing User Guide  85  

 
 

 

Place an Order 

If you want to place an order for items such as house inventory items that are not specifically related to a job, 
then you can select the Tag column box in front of the line item information and click Create PO. 
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Purchasing 

Create New 

To create a new PO, select the Create New button. Then select a Vendor and a Ship To address. 
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Add Line Item  

To add a Line Item click Add Line.  

Select from six types of PO Line items: 

 Job Related Multi Item: Purchases directly tied to a job. (E.g. Buyout/Subcontract).  This option allows 
you to select multiple buyouts for one job to the vendor assigned to the purchase order. 

 Job Related (single item): Purchases directly tied to a job. (E.g. Buyout/Subcontract) This option 
allows you to select one buyout at a time for one job. 

 Non-Inventory: Expense immediately. Will not get used on a job. (E.g. Office supplies). 

 Paper Inventory: Has dollar value/asset account. (E.g. Paper, envelopes. Print system only). 

 Finished Goods: Has dollar value/asset account. (E.g. Binders, Diskettes used for a job). 

 Material Inventory: Has dollar value/asset account. (E.g. Raw Materials: Ink, Labels, Plates). 
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Job Related – Multi Item 

 

To add a PO Type – Job Related Multi Item 

1. Enter or search for a Job # and click Load. (A binocular search button is available to search.) 

  

2. If the job selected has been final AR invoiced, the notation Final Billed will display in red to the right of 
the job description.  

Note Job related purchase orders cannot be created if the job has been final AR invoiced to the 
customer. 

  

 If the Ordered column reflects an N, then the PO line item has not yet been ordered. Y indicates the PO 
line item has been purchased. 
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3. Check the Tag check box to order each item or select Check All to select all buyouts for the job. Insert 
the requested Due Date and the applicable Tax Code.  

 Click Create PO Line Item. 

  

Note If you receive the error message, “activity code has an invalid A/P dissection code” after you 
select the OK button, this indicates the database is not set up to use the Purchasing module or 
you have not properly linked the activity code assigned for the process to a valid AP Dissection 
code in Master File Reports/ Accounting Structure / Link to Purchasing. Consult your system 
administrator or your EFI PrintStream Support contact. 

4. PrintStream will now display the number of PO lines added. Click Cancel or the X in the upper right-
hand corner to close this window. 
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5. The lines selected will now display on the header page of the purchase order.   

  

6 Click Save to retain this PO information. 

Job Related (Single Item) 

To add the PO Type – Job Related (Single Item) 

1. Select Job Related. 

  

2. Select a Job # or use the binoculars to search for the job number. 

  

  



V21.1.0200 Purchasing User Guide  91  

 
 

 

3. You can manually enter in the material to purchase or click Planned Purchases to view a list of 
buyouts or materials related to the job number. 

  

4. In the Description column, items with a dark circle have been ordered. Those with a light circle have 
not. To order items, double-click the line and enter or change any information as needed: PrintStream 
will calculate the cost based on the quantity and price defined.  

  

 Mandatory fields (in bold) are:  Qty/Hrs, Price, Price Per, Due Date, Activity Code and Tax Code 
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PO Line Item Notes 

Click Notes to enter line item descriptions. If a script was attached to a buyout, the script answers will appear in 
the Notes field. 

 

 

These notes will display in Inventory Manger > Scripts/Po Notes when the item is selected to be received. 



V21.1.0200 Purchasing User Guide  93  
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List of Activity Codes 

If needed, enter a required Activity code directly into the field. Either scroll down, use the up/down arrow keys or 
select the binocular icon to search for a list of activity codes. Double-click to select or highlight and select OK. 

Note If you receive the error message, “activity code has an invalid A/P dissection code” after you select the 
OK button, this indicates the database is not setup to utilize the Purchasing module or you have not 
properly linked the activity code assigned for the process to a valid AP Dissection code in Master File 
Reports/ Accounting Structure / Link to Purchasing. Consult your system administrator or your EFI 
PrintStream Accounting Support contact. 
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Click Save to retain PO information. 

Non-Inventory 

To add the PO Type – Non-Inventory 

1. Select Non-Inventory. 

  

2. Enter in the information for what is being purchased. System will calculate the cost. 

 Mandatory fields:  

 Order Date 

 Qty/Hrs 

 Price 

 Per 

 Due Date 

 AP Code 

 Tax Code. 
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3. Click OK, when finished. 

Paper Inventory  

This line type allows the user to purchase paper inventory held in the warehouse and used for multiple jobs; not 
specifically purchased for one job. 

To add PO Type – Paper Inventory 

1. Select Paper Inventory. 

  

2. Either enter the item number or click the search button (binoculars) to search for the paper inventory 
item. 
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 The search inventory window:  
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3. Enter information or select Search. An indication of the number of records loaded will be displayed. 

Note The default is to load only 300 records. This default can be changed, and more items may be 
available which meet the criteria.   

  

4. Select the item to order and then click Select or double-click the item itself. 

 The information stored in the system for this item is automatically populated. 

  

5. Enter Quantity, Price and Due Date.  
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6. Click Reservations to see all job quantity requirements for this item. 

  

  

Finished Goods 

To add the PO Type – Finished Goods 

1. Select Finished Goods. 

  

2. Click Add Line and then select Finished Good to add a new line item. Enter or search for the Item #, 
or you can create a new finished goods item from within the Finished Goods Line Item window. 

3. After selecting the finished goods item, verify: 

 Qty/Hrs 

 Price 

 Price Per (if new otherwise will bring in the price per) 
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 Due Date 

 Activity Code 

 Tax Code 

4. Click OK when finished. 

Material Inventory 

To add the PO Type – Material Inventory 

1. Select Material Inventory. 

  

2. Click Add Line and then select Material Inventory to add a new line item. Enter or search for the Item 
# or create a new material item from within the Raw Materials Line Item window. 

2. After selecting the material item, verify: 

 Qty/Hrs 

 Price 

 Price Per (if new otherwise will bring in the price per) 

 Due Date 

 Activity Code 

 Tax Code 
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Edit or Delete a Purchase Order Line Item 

Select the line item and click Edit Line to edit or Delete Line to delete it. Click Save. 
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Receiving Instructions 

You can enter notes, which will print out on the receiving ticket or display during the actual receipt of the item.  
Click Receiving Instructions and enter the text. Click Save. 
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Update Job changes 

This feature will take any changes done in the estimate and overwrite the PO changes (for example, notes, 
scripts, etc.) 
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Header Notes 

These notes are only viewable from this area. 

 

  

Commented [MB6]: Need a description here? 
Brandon Turpin – descripton added. 
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Preview, Print, Export/E-mail a PO 

 Select the Purchase Order from the left side and click the Preview Selected Purchase Order button. 
You can also select Preview from the bottom of the PO Header window.  

  

 To print the purchase order, select the purchase order and click the Print button from the toolbar or 
select the Print option located at the bottom of the PO header screen.  To change the default printer, 
select File / Print Setup. 

Note If you receive a message, “This PO Requires Approval First” when trying to preview or print the 
purchase order, somebody with security access to approve purchase orders must approve the 
PO before continuing.  

 To turn off the Purchasing Approval option, contact your System Administrator. 

 To export a Purchase Order, first preview it and then click the Export button (envelope with the red 
arrow pointing down.)  
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The PO can also be printed or exported/emailed by selecting one of the two icons at the top of the preview 
screen. 

 

View, Add or Edit Existing PO 

Search by: PO Number, Job Number, Vendor code or enter text.  
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To select the PO double click on the order number or highlight any line and click the Select button. 
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Sheeting 
This program was designed to be used with Book Estimating only. It allows reserved inventory rolls to be 
sheeted down to sheets for running through sheetfed presses. 
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PO Monitor 
This window allows you follow the current status of PO’s based on specific criteria. 

 

Job Delivery Date Range - Date range is entered based on PO due date range not job delivery date. 

Not Ordered - displays a list of materials on jobs which have not been ordered. 

Final Delivered – displays a list of POs which have been flagged as Finally Delivered. 

Waiting for Rcpt – displays a list of POs which have not been received. 

Partial Delivered – displays a list of POs which have partial delivery status 

All the above selection types can be filtered by any of the following as well:  CSR, Activity Code, Customer, 
Sales Rep, Job Number, Product Type, Vendor, and Estimator. 

You can generate a report for any of the items on the grid by selecting all or specific items and then clicking 
Report. 
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Reports 
Currently, there is only one report available: The Stock on Order Report. This report shows the status for all 
paper items which are currently on order. 

 

It allows you to filter by PO date range and for all items, and then by a specific item or by a specific vendor.  
Checking the option Include Items not Linked to a Job will include any PO’s that were ordered for inventory 
rather than for a specific job. 

 

 

 


